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General Rules 

This device is a multifunctional digital microscope, which realized Full HD, high object distance, multifunction,  

multi-output at the same time. With help of the measuring software, it can easily meet many different requiremen

ts in many industries, such as industrial overhaul and teaching demonstration. And its appearance design combi

nes more ergonomic consideration, giving users better experience. We sincerely wish this product can release y

our eyes and improve your work quality. Thanks for your support.  

 

 

◆This operation manual allows you to work safely with the digital Microscope. Please keep this manual for your 

information. Liability is void for any damage caused by not follow this manual.  

◆Failure to follow the warnings and instructions may cause electric shock, fire and/or serious injury. 

◆Not following this note can cause permanent damage to the device. 

◆Storage and transport: Improper transport can harm the device; Always transport this device in the provided 

box in order to prevent damage. 

◆Information on disposal: Electronic equipment does not belong to domestic waste, but must be disposed in 

accordance with the applicable statutory provisions. 

◆In order to bring customers a better experience, we may change the product a little bit during perfecting it. The 

description in this instruction is for reference ONLY. Thanks for understanding. 
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◆Safety 

1.Keep the tool dry, clean, free from oil, water, gas or other materials capable of causing corrosion. 

2.This appliance is not intended for use by people with limited physical, sensory or mental capabilities. 

3.Keep bystanders, children away while operating the tool. 

4.Do not overreach, keep proper footing and balance at all time. 

Basic Parameters 

Image sensor 3 Mega Pixels HD Sensor  

Video output 1080P Full HD (via HDMI) ;720P (via PC) 

Video format MOV 

Magnification ratio Up to 260x (HDMI monitor 22 inch) 

Photo resolution 12M 

Photo format JPEG 

Focus range 5cm to 15cm 

Frame rate Max 30f/s under 600 Lus Brightness 

Video-output interface HDMI/AV  

Storage Micro-SD card, up to 32G (option) 

PC support Yes, for Windows XP/7/8/10, PC software with measurement (gift) 

Power source 5V/2A 

Stand size 20cm*12cm*17cm 

Screen size 5 inch 

Accessories Stand*1, Power Adaptor*1, USB Cable*1, HDMI Cable*1, Manual*1, 

IR controller*1 

Packing data 28*22*17cm/1.9kg 
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Parts of ADSM301 

◆Main Device 
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*Fasten screw: It aims to adjust the compactness between the Lifting stand and the Distance controllers, so users 

can fasten the distance from the lens to the object table.  

 

 

 

◆Remote Controller 
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*Frozen: Stop the image on the screen. It works at standby, record and capture modes. 

*Zoom in&out: digital zooming in to 4 times. 

*Brightness up&down: exposure compensation from +2.0 to -2.0. 

*Lock/unlock: to lock the file when it’s recording. So the video file which has been locked won’t be covered by new 

files when the memory card is full. 

*Sharpness up&down: there are three levels of sharpness: Soft/Normal/Strong. Those two buttons are both used 

to switch the levels, but in different orders.  

*Contrast up&down: same principle as Sharpness. 

*Inverse: refer to pictures in below: 

Normal                                         Inverse 

                                               

*Black&white: refer to pictures in below 

Normal                                         Black&White 
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Connect & Outputs 

Generally, it has 5 ways to output, including its own monitor can show image itself. And the rest four are : HDMI, 

AV/TV, USB and memory card. The airscape in below shows the different ports on the device. In the next few 

chapters, there are more details about each of them. 
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①：AV output.(You need a separated AV cable to connect the device to the monitor, when you need to use AV 

output. There is no AV cable in the standard configuration) 

②：Memory card. (In order to save video files and capture results) 

③：USB output. (You need a separated USB cable to connect the device to the PC, when you need to use USB 

output) 

④：HDMI output. (You need a separated HDMI cable to connect the device to the HDMI monitor, when you need 

to use HDMI output) 

⑤：Connect the device to the switch.  

⑥：Connect the switch to the power supply. 

⑦：Connect the two goose lights to the switch. 

⑧：The switch. It has three buttons. The one on the left is ON/OFF, to get or break the connection between the 

device and the power supply. The rest two are for the two goose lights. The middle one means ‘brightness up’, 

the right one means ’brightness down’. Please do not press the ON/OFF button too often: invertal should be over 

10 seconds.  

General Use 

◆Use Individually 

1. According to the instructions given by last chapters, connect the camera to the power supply like⑤⑥⑦.  

2. Press the ‘ON/OFF’ button on the monitor. (Sometimes the camera will switch on automatically when it is 

connected to the power supply)  

3. Turn on the LED lights, adjust the object distance wheel and the focus controller to get the image that you 

want.  
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4. Use the ‘UP/DOWN’ to zoom in/out. 

 

*To switch mode: 

1. Press ’M’ shortly. (Or press the ‘Mode’ on the remote) 

2. Icons definition in different modes: 

: standby mode; : capture mode; : record mode; : image playback mode  

: video playback mode (If the files are videos, press ’OK’ to play the video file) 

: Lock the file which is being recording 

 

*To set the menu for record mode: 

1. Press ’M’ for few seconds until on the screen shows the menu. (Or press ’MENU’ on the remote.) 

2. Press ‘UP/DOWN’ and use ’OK’ to choose what to set. 

3. Press ’M’ again when you are done. 

 

*To set the menu for system: 

1. Press ’M’ for few seconds until on the screen shows the menu. Then press ’M’ again to get into the system 

setting menu. (Or press ’MENU’ on the remote twice) 

2. Press ‘UP/DOWN’ and use ’OK’ to choose what to set. 

3. Press ’M’ again when you are done. 

 

*To set the menu for capture mode: 

1. Get into the capture mode and then press ’M’ . 

2. Press ‘UP/DOWN’ and use ’OK’ to choose what to set. 

*To capture pictures, three ways: 

1.Press ’M’ shortly to get into the Capture mode. Press ’OK’ to take pictures. 

2.Press ’Capture’ on the monitor only. 

3.Press ’Capture’ button on the IR remote to get pictures.  
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* To record videos: 

1.Press ’M’ shortly to get into the Record mode. Press ’OK’ to start recording. 

2.Press ’OK’ to stop recording. 

PS: Press ’Lock&unlock’ on the remote to lock the file when it’s recording. So the video file won’t be covered by 

new files when the memory card is full. 

 

◆HDMI 

·First, make sure that the monitor connecting to the microscope is literally HDMI monitor. Otherwise it won’t 

perform as good as we expected. 

·Second, connect the microscope to the HDMI monitor, also, connect it to the power supply. Because there is no 

built-in battery in the device, so make sure the microscope is always in charging when you use it.  

·Third, turn on the microscope and adjust the distance. Then put the object on the table and adjust the focus 

controller. 

·It won’t show anything on it’s own screen when it is connected to other equipment. So it’s normal that when you 

use it as HDMI output, the 5 inch screen keeps being dark.  

·You still can take pictures and save them if you have a memory card inside the microscope. But you can’t record 

videos in this output mode. 

 

 

FAQ 

•Why is there no image on the monitor ? 

Please check all the cables connect properly and also make sure the device is switched on.  

•Why the image is not clear ? 

Please adjust the object distance and the focus controller, check the direction of the LED lights, and make sure the 

lens is clean enough. 

•Remote doesn’t work ? 

There is no battery inside of the remote as standard configuration. Please check if there is battery in the remote.  

•Why is there no image in playback model ? 

Sometimes the video file is too big, the system needs time to process. 

•SD card error 

Make sure the memory card you use is certified and quality. Format the memory card in the system first, then try 
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again.  

•To save the setting of the main device. 

In any mode, press Menu button twice to access settings. If you have changed any of the settings in the menu, 

and want to save them, press the ON/OFF button on the main device to turn the device off, then turn it on again. 

Don’t simply disconnect the power supply or press the on/off button on the Switch(or some people call : dimmer), 

in which way the settings won’t be saved.  

             

 

◆USB 
Software Installation 

＊Download the software first:  

https://bit.ly/3j2haLh 

 

So far the measuring software ‘Microscope Measure’ can only support Windows system. If you can’t open the 

links or get problem with downloading these files, please ask customer service to send you separately.  

 

System support: 

Windows XP SP3, Windows 7,Windows8,Windows10 

 

https://bit.ly/3j2haLh
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Process circumstances： 

Microsoft.Net Framework 4.0 

Microsoft Visual C++ 2010 Runtime 

If there isn't either of the runtimes above mentioned, there would be mistake during installation.  

 

＊Open the zip file that you’ve download and run it.  

 

Software Operation   

    

*Icons Definitions 
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＊Interface Definitions and Functions 

 

 

 

 

 Zoom In  Measuring a 3points angle (degree) 

 Normal   Distance of parallel lines(Length) 

 Zoom out  Distance of a point and a line (Length) 

 Undoes the last action  Distance of 2 circles (Radius, length) 

 Cross hairs (crosier,4 grid, 8 grid)  Distance of a line and a circle(Radius, length) 

 Distance of 2 horizontal points  Add a square mark 

 Distance of 2 vertical points  Add a circle mark 

 Distance of any 2 points  Add text 

 
Measuring a rectangular 

(width,height, circumference&area) 

 Distance of 2 lines(Length) 

 Measuring an ellipse(Long-axis radius, short-axis 

radius, circumference&area) 

 3 points circle 

(radius, circumference&area) 

 Measuring a radius circle(radius, circumference&area)  Edge detection 

 Measuring a diameter circle 

(diameter, circumference&area)  

Brightness increase/decrease 

 Measuring a 3 points circle(radius, circumference&area)  Flip horizontal 

 Measuring a 3 points arc  

(radius,degree,circumference&area) 

 Sharpen 

 Measuring a polygon (circumference&area)  Smooth 

 Measuring fold-lines (length)  Take a picture 

 Measuring a 4 points angle (degree)   Take a video 
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①Main menu: 

Here, users can open different devices or lead in pictures to observe or edit, do video setting or save setting, 

choose which windows to show or hide etc. 

②toolbar:  

Here are the tools that would be useful for users to do measuring and image analysis. Definition and function of 

different tools would be given in chapter ’Icons definitions’. Users can choose to hide or show this toolbar in 

‘View→Toolbars and Docking Windows→Standard’. 

③Pictures browser:  

Here is where users can review all pictures they’ve captured. Users can also edit the picture by right clicking the 

picture and open it in the main operating window. Choose ’View→Toolbars and Docking Windows→Picture 

browser’ to show or hide this window. 

④Secondary operating window: 

The image showing in this window always follows your cursor, and with a bigger magnification. With help of this 

window, the result of measuring can be much more precisely. 

It belongs to window ’Pictures browser’.  

⑤Main operating window: 
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This windows shows the full view from the microscope. And it is also the place where users do measuring and 

image analysis. 

⑥Calibration Management and Measuring Results: 

These two windows shows at the same place, users can switch at the bottom of this window. 

   

 

 

◆Calibration Management                           ◆Measure Results 

 

     

                        → Shows the list of different                         → Shows the size of the  

Calibrations. Users can apply                        whole view. Users Can  

or delete the one they want.                         change it in ‘File→ 

                                              Videosetting→Video 

                                              capture pin→(S)’. 

 

 

 

                        →Where to set new                                 → Shows all results of 

Calibrators. (The details of how                       measuring. 

 to set calibrator would be  

given in another chapter) 
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＊Operating Steps 

1）Material: PC (Windows system, with software ‘Microscope Measure’); USB microscope (device name:’USB 

Camera’), Ruler.  

 

2）Steps: 

1,Open the software ’Microscope Measure’. 

2,Click ‘File’→ ‘Open’→ ‘Open Device’→’USB MODE’→’USB Camera’. 

 

 

 

 

＊Functions 

 

1）Calibration 

 

1, Put the ruler under the digital microscope, adjust the focus wheel and the height of the  

stand, to get the best clearance. (during the rest of the process, do not change the object  

distance any more). 

 

2, In the ‘Calibration management’ set the name and unit length of the new calibration(refer 

 the picture on the right). Then, click ’Calibration’, meanwhile, the ’   ‘  in the toolbar should 

 have been chosen automatically. If not, please choose it yourselves. 
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3, Move the cursor to the main operation window, draw a line (the length is the unit length 

 which has been set in step 2) with help of the ruler. After these, click the ’Finish’ button in  

the bottom of the ‘Calibration Management’ window. 

 

4, Check. The length of the line you draw in step 3 should become as the unit length. The  

name of the new calibration should have showed in the list of calibrations.  

 

3) 

 

4) 
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2) Measuring 

1, Choose the tool you need to do measuring in the toolbar. 

2, Click dots or draw lines that you need to measure in the main operating window. 

3, Place the results of measuring in a proper place around the target. 

 

3) Special Effect 

·Includes: Edge detection, Inverse color, Flip horizontal, Relief, Sharpen and Smooth. 

·Steps: 

1, Choose the special effect you need in the toolbar. 

2, In the main operating window, long press the Left to draw a rectangle which can covers the whole target area, 

loose the Left, get the special effect result. 

3, Click Left again, end the special effect. 

PS: If you want to use ’Flip horizontal’, draw a random rectangle in the view, and the whole view would be flipped.  

Click Left again, end the special effect. 

4) Capture and Recording 

·Capture 

1, Click ‘ ’ to capture. 

2, The result of capture can be checked and deleted in the ‘Picture browser’ window. 

3, Check and change the save path: ‘File→Save Setting→Path’. 

·Recording 

1, Choose the size of the view as 640*480 in ‘File→Video Setting→Video Capture Pin→Output size(S)’. 

2, Click ‘ ’, set some other things and start to record. 

                      

3, On the top left corner there shows ‘recording’ and a timer. It means it’s recording. 
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4, Check and change the save path: ‘File→Save Setting→Path’. 

 

FAQ 

1. Why there says ’missing files’ during installation or initiator procedure?  

Please confirm that in the system there are Microsoft. Net Framework 4.0 and Microsoft Visual C++ 2010 

Runtimes. 

2. The software works fine, but the software can not recognize the microscope.  

First, please make sure that you connect the camera and the PC properly and choose ‘PC camera’ on the 5 inch 

monitor. Second, if there is still no image, please check the 'Device Manager’ of your PC, delete the ’USB Camera’ 

in the ’Imaging devices’ and rescan . Let the system identifies again. After all, in the ‘Imaging devices’ there will 

show another name, which is ‘Microscope Measure’. Then restart the software. 

3.Why there is a measurement error? 

First, if you want to get a more precise result, you need to use a more precise calibration. Second, during the 

whole process, make sure the magnification is always the same as the one when you set the calibration. Since the 

camera is continuously magnifying, you’d better keep the same object distance also. 

4.The software is in Chinese? 

Software download link: https://bit.ly/3j2haLh  

Our software basically has two languages: Chinese and English, when the computers systems are not in Chinese, 

the software should be in English automatically, but somehow, it didn't happen that way sometimes. From 

customers feedbacks, we noticed that many users have the issue with the language changing. Sorry for the 

inconvenience. 

The easiest solution: click the third button from left on the menu, there will show ‘Chinese, Chinese, English’ and 

then choose ‘English’. See the picture in below. 

 

 

 

https://bit.ly/3j2haLh
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Warranty Card 

Warranty Card 

User’s name： Address： 

Phone number： Post code： email： 

Model name： Purchase date： 

Fault feedback： 

Date： Fault： 

 

Notice： 

Our warranty doesn’t cover: 

1 If users can not provide the purchase proof or the Warranty. 

2 If users use it in an improper environment, such as incompatible power supply, high 

temperature environment etc. 

3 If the fault caused by accident, oversight, misoperation or natural disasters etc. 

4 If the fault caused by people who are not belong to authorized organizations of our company 

during  repacking, repair, dismantle, Or if users repack, repair or dismantle the device not 
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 following our advice. 

5 Out of warranty period. 
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Reglas Generales 

Este dispositivo es un microscopio digital multifuncional, con Full HD, posibilidad de alta distancia al objeto, 

multifunción con salida múltiple al mismo tiempo. Con la ayuda del software de medición, puede cumplir 

fácilmente con muchos requisitos diferentes en muchas industrias, como la revisión industrial y la demostración 

de enseñanza. Y su diseño de apariencia combina una consideración más ergonómica, brindando a los usuarios 

una mejor experiencia. Deseamos sinceramente que este producto pueda liberar sus ojos y mejorar la calidad de 

su trabajo. Gracias por su elección.  

 

 

◆ Este manual de funcionamiento le permite trabajar de forma segura con el microscopio digital. Conserve este 

manual para su información. La responsabilidad es nula por cualquier daño causado por no seguir este manual. 

◆ El incumplimiento de las advertencias e instrucciones puede provocar descargas eléctricas, incendios y / o 

lesiones graves. 

◆ No seguir esta nota puede causar daños permanentes al dispositivo. 

◆ Almacenamiento y transporte: un transporte inadecuado puede dañar el dispositivo; Transporte siempre este 

dispositivo en la caja proporcionada para evitar daños. 

◆ Información sobre la eliminación: Los equipos electrónicos no pertenecen a la basura doméstica, pero deben 

eliminarse de acuerdo con las disposiciones legales aplicables. 

◆  Para brindar a los clientes una mejor experiencia, podemos cambiar un poco el producto durante su 

perfeccionamiento. La descripción en esta instrucción es ÚNICAMENTE para referencia. Gracias por entender. 

◆ Seguridad 

1. Mantenga la herramienta seca, limpia, libre de aceite, agua, gas u otros materiales que puedan causar 

corrosión. 

2.Este aparato no está diseñado para ser utilizado por personas con capacidades físicas, sensoriales o mentales 

limitadas. 

3. Mantenga alejados a los transeúntes y a los niños mientras utiliza la herramienta. 

4. No se exceda, mantenga el equilibrio y el equilibrio en todo momento. 
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Parametros Básicos 

 

 

Sensor de imagen Sensor de 3 Mega Pixels HD  

Salida de Video 1080P Full HD (via HDMI) ;720P (via PC) 

Formato de Video MOV 

Aumentos Hasta 260x (Monitor HDMI 22 pulgadas) 

Resolución fotográfica 12M 

Formato fotos JPEG 

Rango de enfoque 5cm to 15cm 

Velocidad de disparo Max 30f/s por debajo de 600 Lux de brillo 

Interface de salida de video HDMI/AV  

Almacenamiento Tarjeta Micro-SD, hasta 32G (opcional) 

Soporte PC Si, a partir de Windows XP/7/8/10, software PC con medición 

Alimentación 5V/2A 

Tamaño 20cm*12cm*17cm 

Tamaño pantalla 5 inch 

Accesorios Stand*1, Power Adaptor*1, USB Cable*1, HDMI Cable*1, 

Manual*1, IR controller*1 

Dimensiones embalaje/peso 28*22*17cm/1.9kg 
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Partes del ADSM301 

◆Dispositivo Principal 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Tornillo de sujeción (Fasten srew): tiene como objetivo ajustar la compacidad entre el soporte de elevación y los 

controladores de distancia, para que los usuarios puedan ajustar la distancia desde la lente a la mesa de objetos. 

 

 



              

 

 - 5 - 

 

 

◆Control Remoto 

 

 

 

 

 

 

 

 

 

     

 

 

 

 

   

 

* Congelado (Frozen): detiene la imagen en la pantalla. Funciona en los modos de espera, grabación y captura. 

* Acercar y alejar (Zoom in&out): zoom digital 4 veces. 

* Brillo arriba y abajo (Brightness up&down): compensación de exposición de +2.0 a -2.0. 

* Bloquear / desbloquear (Lock/unlock): para bloquear el archivo cuando se está grabando. Por lo tanto, el archivo 

de video que se ha bloqueado no estará cubierto por archivos nuevos cuando la tarjeta de memoria esté llena. 

* Nitidez arriba y abajo (Sharpness up&down): hay tres niveles de nitidez: Suave / Normal / Fuerte. Esos dos 

botones se utilizan para cambiar los niveles, pero en diferentes órdenes.*Contrast up&down: same principle as 

Sharpness. 

*Inverso (Inverse): consulte las imágenes a continuación: 

 

Normal                                         Inverso 
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*Blanco y Negro: ver los cuadros de abajo: 

Normal                                         Blanco y Negro 
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Conexionado & Salidas 

Generalmente, tiene 5 formas de salida, incluido su propio monitor que puede mostrar la imagen en sí. Y los 

cuatro restantes son: HDMI, AV / TV, USB y tarjeta de memoria. El diagrama inferior muestra los diferentes puertos 

del dispositivo. En los siguientes capítulos, hay más detalles sobre cada uno de ellos. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

①：Salida AV. (Necesita un cable AV separado para conectar el dispositivo al monitor, cuando necesita usar la 
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salida AV. No hay cable AV en la configuración estándar) 

②：Tarjeta de memoria (no incluída). (Para guardar archivos de video y capturar resultados) 

③：Salida USB. (Necesita un cable USB por separado para conectar el dispositivo a la PC, cuando use la salida 

USB) 

④ ： Salida HDMI. (Necesita un cable HDMI no incluído para conectar el dispositivo al monitor HDMI, cuando 

vaya a usar la salida HDMI) 

⑤ ： Conecte el interruptor del dispositivo 

⑥ ： Conecte el interruptor de la fuente de alimentación. 

⑦ ： Conecte las dos luces de flexo al interruptor. 

⑧：El interruptor tiene tres botones. El de la izquierda es ON / OFF, para conectar o desconectar la conexión 

entre el dispositivo y la fuente de alimentación. Los dos restantes son para las dos luces de flexo. El del medio 

significa "aumento de brillo", el de la derecha significa "disminución de brillo". No presione el botón ON / OFF con 

demasiada frecuencia: la inversión debe durar más de 10 segundos. 

Uso General 

◆Uso Individual 

1. De acuerdo a las instrucciones dadas en los capítulos anteriores, conecte la Fuente de alimentación como en 

los puntos ⑤⑥⑦.  

2. Presione el botón "ON / OFF" en el monitor. (A veces, la cámara se enciende automáticamente cuando está 

conectada a la fuente de alimentación) 

3. Encienda las luces LED, ajuste la rueda de distancia del objeto y el controlador de enfoque para obtener la 

imagen que desea.  

4. Utilice ARRIBA / ABAJO (UP/DOWN) para acercar / alejar la imagen 

 

*Para cambiar de modo:: 

1. Presione 'M' brevemente. (O presione el "Modo" en el control remoto) 

2. Definición de iconos en diferentes modos: 

: modo standby; : modo captura; : modo grabación; : modo reproducción de imágenes; 

: modo reprodcción de videos (Si los archivos son videos, presione ’OK’ para reproducir el fichero de video) 

: Bloquear o proteger frente el borrado al fichero que está siendo grabado 
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* Para configurar el menú para el modo de grabación: 

1. Presione 'M' durante unos segundos hasta que en la pantalla se muestre el menú. (O presione 'MENÚ' en el 

control remoto). 

2. Presione “ARRIBA / ABAJO (UP/DOWN)” y use "OK" para elegir qué configurar. 

3. Presione 'M' nuevamente cuando haya terminado. 

 

* Para configurar el menú del sistema: 

1. Presione 'M' durante unos segundos hasta que en la pantalla se muestre el menú. Luego presione 'M' 

nuevamente para ingresar al menú de configuración del sistema. (O presione 'MENÚ' en el control remoto dos 

veces) 

2. Presione " ARRIBA / ABAJO (UP/DOWN)" y use "OK" para elegir qué configurar. 

3. Presione 'M' nuevamente cuando haya terminado. 

 

* Para configurar el menú para el modo de captura: 

1. Entre en el modo de captura y luego presione 'M'. 

2. Presione "ARRIBA / ABAJO (UP/DOWN)" y use "OK" para elegir qué configurar. 

* Para capturar imágenes, de tres formas: 

1.Pulse "M" brevemente para acceder al modo de captura. Presione "OK" para tomar fotografías. 

2.Pulse "Capturar" solo en el monitor. 

3.Pulse el botón "Capturar" del mando a distancia por infrarrojos para obtener imágenes. 

 

* Para grabar videos: 

1.Pulse "M" brevemente para entrar en el modo de grabación. Presione "OK" para comenzar a grabar. 

2.Pulse "OK" para detener la grabación. 

PD: Presiona "Bloquear y desbloquear" en el control remoto para bloquear el archivo cuando se está grabando. 

Por lo tanto, el archivo de video no estará cubierto por archivos nuevos cuando la tarjeta de memoria esté llena. 

◆HDMI 

· Primero, asegúrese de que el monitor que se conecta al microscopio sea literalmente un monitor HDMI. De lo 

contrario, no funcionará tan bien como esperábamos. 

· Segundo, conecte el microscopio al monitor HDMI, también, conéctelo a la fuente de alimentación. Debido a 

que no hay batería incorporada en el dispositivo, asegúrese de que el microscopio esté siempre cargándose 
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cuando lo use. 

· En tercer lugar, encienda el microscopio y ajuste la distancia. Luego coloque el objeto sobre la mesa y ajuste el 

controlador de enfoque. 

· No mostrará nada en su propia pantalla cuando esté conectado a otro equipo. Por eso es normal que cuando 

lo usas como salida HDMI, la pantalla de 5 pulgadas siga estando oscura. 

· Aún puede tomar fotografías y guardarlas si tiene una tarjeta de memoria dentro del microscopio. Pero no puede 

grabar videos en este modo de salida. 

 

FAQ 

• ¿Por qué no hay imagen en el monitor? 

Verifique que todos los cables estén conectados correctamente y también asegúrese de que el dispositivo esté 

encendido. 

• ¿Por qué la imagen no es clara? 

Ajuste la distancia del objeto y el controlador de enfoque, verifique la dirección de las luces LED y asegúrese de 

que la lente esté lo suficientemente limpia. 

• ¿El control remoto no funciona? 

No hay batería dentro del control remoto como configuración estándar. Verifique si hay batería en el control 

remoto. 

• ¿Por qué no hay imagen en el modelo de reproducción? 

A veces, el archivo de video es demasiado grande, el sistema necesita tiempo para procesarlo. 

• Error de tarjeta SD 

Asegúrese de que la tarjeta de memoria que utiliza esté certificada y sea de calidad. Primero, formatee la tarjeta 

de memoria en el sistema y luego vuelva a intentarlo. 

• Para guardar la configuración del dispositivo principal. 

En cualquier modo, presione el botón Menú dos veces para acceder a la configuración. Si ha cambiado alguna 

de las configuraciones en el menú y desea guardarlas, presione el botón ON / OFF en el dispositivo principal 

para apagar el dispositivo, luego vuelva a encenderlo. No desconecte simplemente la fuente de alimentación o 

presione el botón de encendido / apagado en el interruptor (o algunas personas llaman: atenuador), de esa 

manera no se guardarán los ajustes. 
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◆USB 
Instalación del Software 

＊Descargar el software primero de esta dirección:  

https://bit.ly/3j2haLh 

 

Hasta ahora, el software de medición "Microscope Measure" solo es compatible con el sistema Windows. Si no 

puede abrir los enlaces o tiene problemas para descargar estos archivos, solicite al servicio de atención al cliente 

que se los envíe por separado. 

 

Soporte del sistema: 

Windows XP SP3, Windows 7, Windows8, Windows10 

 

Circunstancias del proceso: 

Microsoft.Net Framework 4.0 

Microsoft Visual C ++ 2010 

 

Si no existe ninguno de los programas de ejecucción anteriores, se produciría un error durante la instalación. 

 

＊ Abra el archivo zip que ha descargado y ejecútelo. 

https://bit.ly/3j2haLh
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Manejo del Software  

   

*Definiciones de Iconos 

 

 

 

 

 Acercarse  Medir un ángulo de 3 puntos (grados) 

 Normal  Distancia de líneas paralelas (longitud) 

 Disminuir el zoom  Distancia de un punto y una línea (longitud) 

 Deshace la última acción  Distancia de 2 círculos (radio, longitud) 

 

Cruz (báculo, 4 rejillas, 8 rejillas) 

 Distancia de una línea y un círculo (Radio, 

longitud) 

 Distancia de 2 puntos horizontales  Agregar una marca cuadrada 

 Distancia de 2 puntos verticales  Agregar una marca circular 

 Distancia de 2 puntos cualesquiera  Añadir texto 

 Midiendo un rectángulo 

 Distancia de 2 líneas (longitud) 

 (ancho, alto, circunferencia y área)  Círculo de 3 puntos 

 Medir una elipse (radio de eje largo, radio de eje corto, 

circunferencia y área) 
 (radio, circunferencia y área) 

 

Medir un círculo de radio (radio, circunferencia y área)  

Detección de bordes 

 Medir un círculo de diámetro  Aumento / disminución de brillo 

 (diámetro, circunferencia y área)  Flip horizontal 

 Medir un círculo de 3 puntos (radio, circunferencia y 

área) 
 Afilar 

 Medir un arco de 3 puntos  Suave 

 (radio, grado, circunferencia y área)  Toma una foto 
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＊Definiciones del Interface y Funciones 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

①Menu principal: 

Aquí, los usuarios pueden abrir diferentes dispositivos o mostrar imágenes para observar o editar, realizar ajustes de 

video o guardar ajustes, elegir qué ventanas mostrar u ocultar, etc. 

②Barra de herramientas:  

Estas son las herramientas que serían útiles para que los usuarios realicen mediciones y análisis de imágenes. La 

definición y función de las diferentes herramientas se daría en el capítulo "Definiciones de iconos". Los usuarios pueden 

optar por ocultar o mostrar esta barra de herramientas en "Ver → Barras de herramientas y ventanas de acoplamiento 

→ Estándar". 

③Navegador de imágenes:  

Aquí es donde los usuarios pueden revisar todas las imágenes que han capturado. Los usuarios también pueden editar 

la imagen haciendo clic con el botón derecho en la imagen y abrirla en la ventana principal de funcionamiento. Elija 'Ver 

→ Barras de herramientas y ventanas de acoplamiento → Explorador de imágenes' para mostrar u ocultar esta 

ventana. 

④Ventana secundaria de imágenes: 

La imagen que se muestra en esta ventana siempre sigue al cursor y con un aumento mayor. Con la ayuda de esta 

ventana, el resultado de la medición puede ser mucho más preciso. 

Pertenece a la ventana "Navegador de imágenes". 
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⑤Ventana de operación principal: 

Esta ventana muestra la vista completa desde el microscopio. Y también es el lugar donde los usuarios realizan 

mediciones y análisis de imágenes. 

⑥Gestión de calibración y resultados de medición: 

  Estas dos ventanas se muestran en el mismo lugar, los usuarios pueden cambiar en la parte inferior de esta  

  ventana.  

        

 

 

◆Calibration Management                           ◆Measure Results 

 

→ Muestra una lista de                              → Muestra el tamaño de  

  calibraciones diferentes.                            toda la vista. Los usuarios  

  Los usuarios pueden escoger                        pueden cambiarla en ‘File→  

  o eliminar la que quieran                           Videosetting→Video 

             capture pin→(S)’.                                              

 →Donde se configuran                                 

  nuevas calibraciones.(los                          → Muestra todos los detalles 

detalles de como es                                de medición 

configurado el calibrador  

están en otro capítulo 
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＊Operativa 

1 ） Material: PC (system Windows, con software ‘Microscope Measure’); Microscopio USB (Dispositivo 

llamado:’USB Camera’), Reglas.  

 

2）Pasos: 

1,Abra el Software ’Microscope Measure’. 

2,Haga click ‘File’→ ‘Open’→ ‘Open Device’→’USB MODE’→’USB Camera’. 

 

 

 

 

＊Funciones 

 

1）Calibración 

 

 1, coloque la regla debajo del microscopio digital, ajuste la rueda de enfoque y la altura 

del soporte para obtener el mejor espacio libre. (durante el resto del proceso, no cambie  

la distancia del objeto más). 

 

2, En "Gestión de calibración", establezca el nombre y la longitud de la unidad de la nueva  

calibración (consulte la imagen de la derecha). Entonces haga click en “Calibration”,  

mientras el icono      debería haberse escogido automáticamente. Si no escogerlo por  

uno mismo  

 

3, mueva el cursor a la ventana de operación principal, dibuje una línea (la longitud es la  
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longitud de la unidad que se ha establecido en el paso 2) con la ayuda de la regla. Después de estos, haga clic 

en el botón "Finalizar" en la parte inferior de la ventana "Gestión de calibración". 

 

4, comprobar. La longitud de la línea que dibuja en el paso 3 debe convertirse en la unidad de longitud. El nombre 

de la nueva calibración debería haber aparecido en la lista de calibraciones. 

 

 

3) 

 

4) 
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2) Medir 

1, elija la herramienta que necesita para medir en la barra de herramientas. 

2, haga clic en los puntos o dibuje las líneas que necesite medir en la ventana principal de funcionamiento. 

3, coloque los resultados de la medición en un lugar adecuado alrededor del objetivo. 

 

3) Efecto especial 

· Incluye: detección de bordes, color inverso, volteo horizontal, relieve, nitidez y suavizado. 

·Pasos: 

1, elija el efecto especial que necesita en la barra de herramientas. 

2, en la ventana de funcionamiento principal, mantenga presionado el botón izquierdo para dibujar un rectángulo 

que pueda cubrir toda el área objetivo, suelte el izquierdo y obtenga el resultado del efecto especial. 

3, haga clic en la izquierda de nuevo, finalice el efecto especial. 

PD: si desea utilizar "Voltear horizontalmente", dibuje un rectángulo aleatorio en la vista y se invertirá toda la vista. 

Haga clic en Izquierda nuevamente, finalice el efecto especial. 

4) Captura y grabación 

·Capturar imágenes 

1, Click ‘ ’ para capturar la imagen. 

2, El resultado de la captura se puede comprobar y eliminar en la ventana "Explorador de imágenes". 

3, verifique y cambie la ruta de guardado: ‘File→Save Setting→Path’. 

·Grabación video 

1, Elija el tamaño de la vista como 640 * 480 en ‘File→Video Setting→Video Capture Pin→Output size(S)’. 

2, Hacer click ‘ ’, establecer algunas otras cosas y empezar a grabar. 

                      

3, En la esquina superior izquierda se muestra "grabación" y un temporizador. Significa que está grabando. 

4, Cheque y cambie la ruta del fichero a guardar: ‘File→Save Setting→Path’. 
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FAQ 

1. ¿Por qué dice "archivos perdidos" durante la instalación o el procedimiento de inicio? 

Confirme que en el sistema hay Microsoft Net Framework 4.0 y Microsoft Visual C ++ 2010. 

2. El software funciona bien, pero el software no puede reconocer el microscopio. 

Primero, asegúrese de conectar la cámara y la PC correctamente y elija "Cámara de PC" en el monitor de 5 

pulgadas. En segundo lugar, si aún no hay imagen, verifique el "Administrador de dispositivos" de su PC, elimine 

la "Cámara USB" en los "Dispositivos de imágenes" y vuelva a escanear. Deje que el sistema se identifique 

nuevamente. Después de todo, en los "Dispositivos de imágenes" se mostrará otro nombre, que es "Medida de 

microscopio". Luego reinicie el software. 

3. ¿Por qué hay un error de medición? 

Primero, si desea obtener un resultado más preciso, debe usar una calibración más precisa. En segundo lugar, 

durante todo el proceso, asegúrese de que el aumento sea siempre el mismo que el que tenía cuando estableció 

la calibración. Dado que la cámara se amplía continuamente, es mejor que también mantenga la misma distancia 

del objeto. 

4.¿El software está en chino? 

Enlace de descarga de software: https://bit.ly/3j2haLh 

Nuestro software tiene básicamente dos idiomas: chino e inglés, cuando los sistemas informáticos no están en 

chino, el software debería estar en inglés automáticamente, pero de alguna manera, a veces no sucedía así. A 

partir de los comentarios de los clientes, notamos que muchos usuarios tienen problemas con el cambio de idioma. 

Lo siento por los inconvenientes ocasionados. 

La solución más sencilla: haga clic en el tercer botón de la izquierda en el menú, aparecerá "Chino, chino, inglés" 

y luego seleccione "Inglés". Vea la imagen a continuación. 
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Warranty Card 

 

Warranty Card 

User’s name： Address： 

Phone number： Post code： email： 

Model name： Purchase date： 

Fault feedback： 

Date： Fault： 

 

Notice： 

Our warranty doesn’t cover: 

1 If users can not provide the purchase proof or the Warranty. 

2 If users use it in an improper environment, such as incompatible power supply, high 

temperature environment etc. 

3 If the fault caused by accident, oversight, misoperation or natural disasters etc. 

4 If the fault caused by people who are not belong to authorized organizations of our company 

during  repacking, repair, dismantle, Or if users repack, repair or dismantle the device not 

following our advice. 

5 Out of warranty period. 


